User Guide:
Monetary Award Program
(MAP)



Access and Navigation



Student Eligibility



Payment Processing

Introduction to MAP Processing
The Monetary Award Program (MAP) is administered by schools using the MAP system,
which is available through ISAC’s Gift Assistance Programs (GAP) Access portal at
https://isacportal.isac.org. MAP information is accessed by selecting the MAP tab near the top
of the screen once the school user has successfully logged into GAP Access. Student eligibility
information is accessed via the Student tab, and payment processing, when it becomes available
for an award year, is accessed via the Payment tab.

Quick links to ISAC contact information, the FAA section of ISAC’s website and MAP
program information can be found at the bottom of all MAP system screens, as seen below:

Please note that the MAP system will time out after prolonged inactivity. The following
message will appear to allow you to save your data:
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Student List Eligibility: View Screen
The Student List Eligibility: View screen is accessed from the Student tab. On the Student List
Eligibility: View screen, schools are able to view students who have listed their school as one of
the school choices on the Free Application for Federal Student Aid (FAFSA).

This provides the entry point to other MAP functions such as: viewing detailed
student information, viewing student information history, creating reports, and
associating MAP codes with selected students.

The initial loading of the Student List Eligibility: View page will result in a default view
with the following columns:
- Sel (Select)
- Current SSN (last four digits display)
- Last Name
- First Name
- Transaction #
- Original Yearly Eligible Amount
- Disqualify
- ISAC Default
- Late

- MAP Suspense
- Shutdown
- EFC
- CPS Process Date
- Date of Birth
- Academic Level
- MAP Paid Credit Hours
- Continuing Student
- EFC Change
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Student List Eligibility: View Screen
The screen shots below illustrate the type of data that is provided on the Student List
Eligibility: View screen. To help identify why a student may not be eligible to receive an
award, the Disqualify, ISAC Default, Late, MAP suspense and Shutdown flags will all be
displayed just to the right of the Original Yearly Eligible Amount in the default view.
The
icon provides a link to more detailed information about the student, and the $ icon
provides a link to the enrollment calculator and payment information for the student. In the
column next to the $ icon, a light bulb icon - will be displayed if any flags are on that
could cause the student to be ineligible for an award. Keep in mind that not all flags make a
student totally ineligible for an award. It is up to the school to determine the meaning of the
flag and to what extent it affects the student’s potential award.
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Student List Eligibility: View Instructions
The Student List Eligibility: View screen displays a maximum of one hundred student records. To
view more records, click on the Previous Page, Pages 1-10, or Last Page tabs. To view additional
columns, scroll to the right. Other suggestions for viewing the eligibility screen are listed below.
•

To select students enrolled in or attending your institution, select them by clicking on the
box in the “Sel” column.

•

To view the student’s MAP eligibility data on the Student Detail: Eligibility screen, click on
the magnifying glass icon that is on the same line as the student’s last name.

•

To use the enrollment calculator, click on the dollar sign icon.

•

To filter your view, displaying only those student records that you want to see, click on the
Filter Tab. The Student List Eligibility: Filter screen will be displayed with the various filter
options.

•

To sort the student records, click on the Sort tab. The Student List Eligibility: Sort screen
will be displayed.

•

To view a report of a Student List Eligibility: View screen, click on the “View Report”
button located at the bottom of the screen. A copy of the report can be created in .PDF
format by clicking on the “View Report” tab or in MS Excel by clicking on “Excel Report.”
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Student List Eligibility: Filter Screen
The Student List Eligibility: Filter screen allows you to designate student records that you want to
view on the Student List Eligibility: View screen by selecting parameters for the records that you
want to see. After selecting your filtering criteria, click on the View tab to see your customized list.
For example, if you want to view only those students with a last name of Smith, go to the Last
Name field, select the “=” sign from the drop down menu and enter Smith in the text box next to the
“=” sign. When you return to the Student List View by clicking on the View tab, you will see only
those students with a last name of Smith.
The Filter screen allows you to filter on more than one option, and it can also be used in conjunction
with the options available through the Sort and Columns tabs.

Note: If multiple
“ineligible” boxes
are checked,
records will appear
on the View screen
only if all of the
conditions are met.

Check boxes on the right side of the screen allow you to filter your lists even further. For
example, to view just your undergraduate students, check the “Undergraduates Only” box. In
addition, the eligibility status of records can be viewed by selecting the ineligible conditions.
In addition to viewing the customized list in the MAP system, you can also view and save the
report as a .PDF file by clicking on the View Report tab located at the bottom of the Student List
Eligibility: View screen, or you can view and save the customized list as an Excel file. You can
save your selected view in the MAP system by clicking on the Save Selected tab, however, once
you log out, the settings will be cleared, and the defaulted list will appear the next time you log
in.
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Student List Eligibility: Sort Screen
The Student List Eligibility: Sort screen allows the user to designate the order in which the
records will appear on the Student List: View screen. The default view of the Student List View is
Last Name, First Name, Trans#. By using the Sort function, you can change the order in which
records are sorted, which can be helpful when trying to compare records to your institutional
reports that may be sorted in a different order. The Sort screen can be accessed from the Student
List Eligibility: View screen by clicking on the Sort tab.

To select Sort categories: highlight the item in the Unselected list and click on the arrow icon
to move it to the Selected list. To select more than one item at a time, hold down the Ctrl key
while highlighting the items, then click on the arrow icon.
To remove an item from the Selected list: highlight the item in the Selected column and click
on the arrow icon to move it to the Unselected list. To select more than one item at a time,
hold down the Ctrl key while highlighting the items, then click on arrow icon.
Moves the highlighted item from the Unselected list to the Selected list.
Moves all of the items in the Unselected list to the Selected list.
Moves the highlighted item from the Selected list to the Unselected list.
Moves all of the items in the Selected list to the Unselected list.
To rearrange the items once they are selected, highlight the column title by clicking on it,
then click on the Move Column Up or the
Move Column Down button until the items
are positioned in the order in which you want them to sort.
To sort in descending order, select the appropriate checkboxes. Unchecked checkboxes will
be sorted in ascending order.
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Student List Eligibility: Columns Screen
The Student List Eligibility: Columns Screen allows the user to select columns to display on the
Student List Eligibility: View screen. Clicking on the Columns tab on the Student List Eligibility:
View screen will access the Student List Eligibility: Columns screen.

To add a Column: highlight the item in the Unselected list and click on the arrow icon to
move it to the Selected list. To select more than one item at a time, hold down the Ctrl key
while highlighting the items, then click on the arrow icon.
To remove a Column: highlight the item in the Selected list and click on the arrow icon to
move it to the Unselected list. To select more than one item at a time, hold down the Ctrl
key while highlighting the items, then click on arrow icon.
Moves the highlighted item from the Unselected list to the Selected list.
Moves all of the items in the Unselected list to the Selected list.
Moves the highlighted item from the Selected list to the Unselected list.
Moves all of the items in the Selected list to the Unselected list.
If you want to rearrange the columns once they are selected, select the column you want to
change by clicking on it. When the column is highlighted, click on the Move Column Up
button, or click on the Move Column Down button until the column is in the correct place.
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Suggestions for Using Filter, Sort and Columns Functions
To Create a Report of Suspended Student Records Using the Suspense Flag
Follow the steps below to create a report of suspended student records in “Application Receipt
Date” order:
•
•
•
•
•
•
•
•
•
•
•
•
•

Access the Student tab from the GAP Access MAP menu.
Access the Filter screen by clicking on the Filter tab.
Check the box labeled “MAP Suspend” (lower right section of screen).
Access the Columns screen by clicking on the Columns tab.
Locate “Application Receipt Date” under Unselected Columns; double click on it to move
it to the bottom of the Selected Columns list.
Highlight “Application Receipt Date” and click on the up arrow to move this column to its
desired screen location.
Click the Sort tab.
Locate “Application Receipt Date” under the Unselected Columns; double click on it to
move it to the bottom of the Selected Columns list.
Highlight “Application Receipt Date” and click on the up arrow to move it to the top of
the list.
Click the View tab.
The Eligibility List View now displays a listing of the students with suspended records, in
Application Receipt Date order.
To review a printable listing of these student records, click the View Report or Excel
Report buttons at the bottom of the screen,
To print this report, click on the print icon on your browser's tool bar.

To Identify Records Released from Suspension
When records are released from suspense, ISAC will create an Eligibility Status File (ESF)
update that will remove the “S” from the “MAP Susp” field. There is no indicator in the MAP
system that identifies which student records were released. Following are instructions for
identifying student records that have been released from suspension:
•

After the release of suspended records, use the initial “Application Receipt Date” filter to
create a list of student records using a date range of released records. For example, by
using the 2012-13 release from suspension dates (March 20, 2012 - April 2, 2012), a report
can be created that will identify students by application receipt date (initial FAFSA receipt
date). Schools may then use their standard procedure to request payment for eligible
students.
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Student Detail: Eligibility Screen
The Student Detail: Eligibility screen displays information from the student's selected ISIR
transaction as well as eligibility status information for MAP. The purpose of this screen is to allow
authorized users the ability to view the MAP eligibility details of an individual student record
beginning with the most recent ISIR transaction. The Student Detail: Eligibility screen is accessed
by clicking on the magnifying glass icon - on the Student List Eligibility: View screen.
To view another ISIR transaction, select the desired ISIR number in the Transaction/Name ID drop
down box and click on the Go button. To select another student's Detail screen, enter a new Social
Security Number in the Current SSN field and click on the Go button.

Example of semester school award

Example of quarter school award
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Student Detail: Eligibility Screen
Here is a comprehensive view of the Student Detail: Eligibility screen, including the student
information section, the Details section, and the School Certification Data section.

Student records flagged with the “light bulb” icon on the Student
List: Eligibility View screen, may also include yellow
highlighting on the Student Detail: Eligibility screen on the fields
that may be impacting the student’s eligibility.
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Student Detail: Eligibility Screen

Value

Description of Dependency Codes

D

Dependent

I

Independent

X

Dependency could not be determined.

Y

Dependency could not be determined.

Choices for EFC Change Flag Field
Decrease
Increase
All EFC
Changes
Blank
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Student Detail: Eligibility Screen

Value

Description of Student Change Flag Codes

N

Last Name change

S

Social Security Number change

B

Social Security Number and Last Name change

Blank

Value

Code

Description of SSN Match Flag Codes

1

No match on SSN

2

SSN and Name match, no match on date of birth

3

SSN match, no match on Name.

4

SSN, Name, and date of birth match

5

SSN, Name, date of birth match with date of death

6

Record not sent to Social Security Administration

As Of Date is the date on which
the eligibility status
information was gathered from
the ISAC database.

Definition of Update Type

I

Indicates an initial eligibility status data population.
This means that the fields that follow were all
populated for the first time.

U

Indicates that the data has been updated.

Code

No change

Definition of Disqualify Code

1

Dependent student, parents NOT Illinois residents.

2

Independent student NOT an Illinois resident.

4

Invalid (or blank) class level, such as graduate student.

6

Loan default is overridden; payment is allowed

7

MAP Paid Credit Hours exceed 134.

8

Student is in default on a Stafford loan.

9

Other ISAC disqualify.

Blank

Not disqualified.
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Student Detail: Eligibility Screen

Code

Definition of MAP Suspense Code

S

New application received after the suspense
date will not be considered for an award this
year.

A

Payment request will be processed for full
year.

Q

Payment request will be processed for 2nd
Semester/Quarter as well as 3rd Quarter.
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Student Detail: Eligibility Screen
Code

Definition of Default Code

Y

Student is currently in default on an ISAC
student loan.

N

Student is not currently in default on an ISAC
student loan.

Code

Definition of Paid Previously Code

0

Student was not paid in the previous year.

1

Student was paid the 1st Semester of the
previous year.

2

Student was paid the 2nd Semester of the
previous year.

3

Student was paid the 1st Quarter of the
previous year.

4

Student was paid the 2nd Quarter of the
previous year.

5

Student was paid the
previous year.

3rd

Quarter of the

Code

Definition of Continuing Code

Y

Student filed a FAFSA for the previous year.

N

Student did not file a FAFSA for the previous year.
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This field reports the
number of MAP Paid
Credit Hours that the
student has used. The
values that will appear in
this field will range from
000 to 135.
If this field is blank, it may
be an indication that there
is a conflict on the
applicant’s record. If that
is the case, a “conflict”
message will appear on
the student’s Detail
Screen, and the school
should contact ISAC’s
School Services
Department for resolution.
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Student Detail: Eligibility Screen
Near the bottom of the Student Detail: Eligibility screen is the School Certification Data
section. The flag codes are the same as those found on the student’s ISIR and are defined in
the U.S. Department of Education’s ISIR Guide, which can be accessed at www.ifap.ed.gov.

Also at the bottom of Student Detail Screen is the student’s address as reported on the
FAFSA, as well the student’s Date of Birth and various FAFSA processing dates.
The Application Receipt Date is the date that the student’s first FAFSA was received by the
Central Processing System. (This is the date used by ISAC when determining if a student is
eligible for a MAP grant.)
The CPS Processing Date is the date that the transaction was processed by the Central
Processing System.
Last Update is the date that the student’s record was last updated.
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MAP Eligibility Report
The MAP Eligibility Report displays students that may be eligible for the Monetary Award
Program (MAP) grant. The Reports screen is accessed from the Reports tab. To generate a
report, first click the Create New Report button in the upper right-hand corner of the screen.
Then, select the report type from the Select Report drop down menu and click on the Request
Report button.

Requested reports will be listed as shown below and accessible in Word and Excel formats.
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File Extractions: Eligibility Status Files Screen
The File Extractions: Eligibility Status Files screen is accessed from the File Extractions tab.
To run an extract, first click the Create New File Extraction button in the upper right-hand
corner of the screen. Then, select the extraction type from the Select Report drop down menu
and click on the Request Report button.
The Eligibility Status File (ESF) extraction list provides schools with a list of their previously
extracted ESF files. The ESF extraction can be performed on a variable range of records. The
actual amount of time to perform the extraction could vary dramatically between small ESF
requests containing 100-200 records, and large ones containing 20,000-30,000 records.

Once a request has been completed, an entry for this extraction will appear in a list, as
shown below. From this list, the user will be able to: download an ESF file extraction;
delete any previously extracted ESF files; and/or create a new ESF extraction request.
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